


UVOD 

 

Dragi studenti, 

predstavljamo vam 3. verziju priruļnika kojemu je svrha omoguĺiti vam ġto jednostavnije i 
brģe spajanje na domsku mreģu i internet. Nadamo se da ste upoznati sa ļinjenicom kako od 
proġle godine niste viġe ograniļeni na pristup domskoj mreģi iskljuļivo iz vaġih soba. Naime 
u svim domovima u RH omoguĺen Vam je pristup domskoj mreģi beģiļnim putem i to iz 
zajedniļkih prostorija u kojima nije postavljena ģiļana mreģa.  

Do sada  ste neke  od uvjeta za pristup internetu veĺ ispunili ï imate elektroniļki identitet u 
sustavu AAI@EduHr, koji ste dobili na svojemu fakultetu i postali ste stanar studentskoga 
doma. 

Ovim putem ģeljeli bismo Vam dati nekoliko osnovnih informacija. Moguĺnoġĺu pristupa na 
internet prvenstveno Vam ģelimo olakġati proces studiranja, ġto ukljuļuje pristup obrazovnim, 
znanstvenim i raznim informativnim sadrģajima, te moguĺnost on-line obavljanja 
administrativnih poslova vezanih uz studiranje. 

Ulaskom u studentsku sobu i koriġtenjem usluge besplatnoga pristupa internetu, bilo da se 
radi o ģiļanoj ili beģiļnoj mreģi, automatski se pristali na poġtivanje odreĽenih pravila te se 
od Vas oļekuje da ih se pridrģavate kako bi i svi Vaġi sustanari mogli kvalitetno pristupati 
navedenim sadrģajima i obavljati studentske obveze. Pravila ponaġanja prilikom koriġtenja 
usluge pristupa internetu propisuju studentski centri i nacionalna akademska i istraģivaļka 
mreģa CARNet, a s tim se pravilima moģete upoznati na internetskim stranicama navedenih 
institucija 

U priruļniku koji se nalazi pred Vama opisani su postupci instaliranja i podeġavanja 
programske podrġke na Vaġemu raļunalu za operacijske sustave Microsoft Windows XP, 
Microsoft Windows Vista, Linux te MacOS kako za pristup ģiļanoj mreģi tako i za pristup 
beģiļnoj mreģi. 

Za uporabu domske mreģe, osim ļinjenice da ste stanar doma, trebate imati:  

 vlastito raļunalo s mreģnom karticom i kabel za spajanje u mreģnu utiļnicu ukoliko se 
radi o pristupu ģiļanoj mreģi 
 

 vlastito raļunalo s beģiļnom mreģnom karticom ukoliko se radi o pristupu beģiļnoj 
mreģi 
 

 valjani elektroniļki identitet, koji vam je dodijelila Vaġa matiļna ustanova (fakultet) 
 

 instaliran i konfiguriran softver za autentikaciju (ovisi o operativnome sustavu na 
vaġemu raļunalu i naļinu na koju pristupate domskoj mreģi) u skladu s ovim 
priruļnikom 
 

 konfiguriranu mreģnu karticu za automatski prihvat potrebnih mreģnih parametara u 
skladu s ovim priruļnikom. 

Na ovom CD-u nalaze se instalacijske datoteke potrebne za podeġavanje Vaġega raļunala 
za pristup domskoj mreģi. Umnoģavanje i distribuiranje sadrģaja ovoga CD-a dopuġteno je u 
nekomercijalne svrhe, dok uporaba programske podrġke podlijeģe autorskim pravima i zaġtiti 
intelektualnoga vlasniġtva tvrtki Dynamic Security Solutions (SecureW2) i  Adobe 
(AdobeReader). 



Moguĺnost pristupa infrastrukturi StuDOM izvedena je u skladu sa standardom eduroamÊ.  

Ako i nakon uporabe ovoga priruļnika imate poteġkoĺa sa spajanjem ili dodatnih pitanja, 
obratite se nadleģnoj sluģbi Vaġega studentskog doma, koja ĺe vam pomoĺi u rjeġavanju 
nastaloga problema. 

Ovaj priruļnik pripremio je StuDOM tim Sveuļiliġnog raļunskog centra (Srca) koji brine za 
cjelovitost funkcioniranja StuDOM infrastrukture na razini Republike Hrvatske. Sve 
informacije moģete pronaĺi i na internetskim stranicama naġeg projekta 
(http://studom.srce.hr/,  te na stranicama sustava AAI@EduHr (http://www.aaiedu.hr/), kao i 
na internetskim stranicama Vaġih studentskih centara. 

Nadamo se da ĺe vam ovaj priruļnik olakġati spajanje na mreģu Vaġega doma. Ģelimo Vam 
ugodnu uporabu domske mreģe i studiranje.  

 

 

Vaġ StuDOM tim 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Uvod 

Sadrģaj   

Upute za pristup ģiļanoj mreģi    

    Microsoft Windows XP   

  Microsoft Windows Vista  

              Macintosh  

  Linux   

 

Upute za pristup beģiļnoj mreģi  

    Microsoft Windows XP   

  Microsoft Windows Vista  

    Macintosh  

   Linux   

 

Pravila uporabe mreģe resursa  

Popis studentskih domova   

Pojmovnik   
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Microsoft Windows XP  
 

 Instalirajte klijent SecureW2  
 

Distribucija klijenta SecureW2 s predefiniranim postavkama (profil StuDOM) nalazi se na 
priloģenom CD-u i sadrģi inaļicu klijenta koja je bila aktualna u trenutku nastajanja ovog 
priruļnika. Procedura instalacije i konfiguracije svih potrebnih parametra opisana u ovom 
priruļniku odnosi se na uporabu klijenta SecureW2 preuzetog s CD-a koji dolazi uz priruļnik. 

Najnovija distribucija klijenta SecureW2, ali bez predefiniranog profila StuDOM, moģe se 
pronaĺi na adresi http://www.securew2.org/ u skupini Download. Da biste ispravno instalirali i 
konfigurirali inaļicu SecureW2 preuzetu s interneta, pratite postupak opisan na internetskim 
stranicama http://eduroam.aaiedu.hr/howto-user.html. 

Napomena: Za sve operativne sustave Microsoft Windows rabi se ista inaļica programa 
SecureW2.   
 

Nakon preuzimanja klijenta SecureW2, potrebno ga je raspakirati i pokrenuti instalacijsku 
datoteku. 
Proces instalacije ne zahtijeva promjene niti jednog postavljenog parametra (Next), a nakon 
zavrġetka instalacije potrebno je napraviti reboot sustava (sama instalacijska procedura 
automatski traģi reboot).   

 

 

 Konfigurirajte 802.1X autentikaciju na mreģnom suļelju 
 

 MS Windows XP ï engleska inaļica 
 

Kod uporabe standardnog izbornika Start za postavljanje autentikacije na mreģnom suļelju 
potrebno je napraviti ove korake da bi se dobio popis mreģnih suļelja:  
Start > Connect to > Show all connections. 

Kod uporabe izbornika Classic Start za postavljanje autentikacije na mreģnom suļelju 
potrebno je napraviti ove korake da bi se dobio popis mreģnih suļelja: 
Start > Settings > Network Connections. 
 
Zatim treba desnom tipkom miġa kliknuti na naziv mreģnog suļelja (Local Area Connection) 
i odabrati Properties kao na Slici 1. 



Slika 1 

Nakon otvaranja prozora Local Area Connection Properties, podeġava se prihvaĺanje 
postavki dodijeljenih DHCP protokolom. Potrebno je odabrati Internet Protocol (TCP/IP) i 
kliknuti miġem na dugme Properties kao na Slici 2. 



 
Slika 2 

Otvara se novi prozor u kojemu moraju biti oznaļene moguĺnosti (Slika 3): 

 - Obtain an IP address automatically 

 - Obtain DNS server address automatically 



 
Slika 3 

 
Nakon klika miġem na dugme OK i povratka na prozor Local Area Connection Properties, 
potrebno je odabrati karticu Authentication.  

U sluļaju da nemate Authentication karticu, ako se koristite zakrpom Windows XP Service 
Pack 2, provjerite je li pokrenut servis Wireless Zero Configuration. Ako se koristite 
zakrpom Windows XP Service Pack 3, provjerite je li pokrenut servis Wired AutoConfig. 
Za namjeġtanje bilo kojeg od ova dva servisa koriste se potpuno isti koraci. Ovdje je prikazan 
primjer namjeġtanja servisa WiredAutoConfig. 

 
Kod uporabe standardnog izbornika Start do prozora sa servisima dolazi se na ovaj naļin: 
Start > Control Panel > Switch to Classic View > Administrative Tools > Services. 

 
Kod uporabe izbornika Classic Start do prozora sa servisima dolazi se na ovaj naļin: 
Start > Settings > Control Panel > Switch to Classic View > Administrative Tools > 
Services 

 
Desnim klikom miġa na servis otvara se izbornik iz kojeg je potrebno odabrati Properties 
(Slika 4). 



 
Slika 4 

U postavkama servisa iz padajuĺeg izbornika Startup type potrebno je odabrati moguĺnost 
Automatic, kliknuti miġem na dugme Start, a zatim na dugme OK (Slika 5). 

 
Slika 5 

Na kartici Authentication postavite kvaļicu pored Enable IEEE 802.1X authentication for 
this network i odaberite SecureW2 EAP-TTLS za EAP type. TakoĽer treba provjeriti da 
nema kvaļica pored Authenticate as computer when computer information is available i 
Authenticate as guest when user or computer information is unavailable. Sve postavke 
trebaju biti kao na Slici 6. 



 

 
Slika 6 

Klikom miġa na dugme Properties otvara se prozor SecureW2 Profile u kojem je potrebno 
odabrati profil StuDOM kao na Slici 7. 



 
Slika 7 

Na kraju je dovoljno klikom miġa na dugme OK zatvoriti otvorene prozore vezane uz mreģna 
suļelja. 

Nakon prikljuļenja mreģnog kabela, operacijski sustav Microsoft Windows XP zatraģit ĺe 
unos podataka potrebnih za autentikaciju (Slika 8). 

 
Slika 8 

Klikom miġa na obavijest otvara se prozor SecureW2 Credentials u koji upisujete svoju 
AAI@EduHr korisniļku oznaku i lozinku (Slika 9). 



 
Slika 9 

Korisniļki podaci predstavljaju vaġ e-identitet u sklopu sustava AAI@EduHr i unosite ih u 
ovom obliku: 

- Polje Korisnicka oznaka popunjavate u obliku uid@realm.hr, npr. thorvat@fer.hr 
- Polje Korisnicka lozinka popunjavate svojom lozinkom 
- Polje Domain ostavljate prazno. 

Nakon klika miġem na dugme OK u donjem desnom kutu vaġeg monitora, iznad ikone za 
mreģnu vezu, trebali biste vidjeti oznaku uspjeġnog spajanja na mreģu u kojem treba pisati: 
ĂLocal Area Connection is now connected Speed: 100.0Mbpsò (Slika 10). 

 
Slika 10 

 

 

 

 

 

 

 

 



 MS Windows XP ï hrvatska inaļica 

Kod uporabe standardnog izbornika Start za postavljanje autentikacije na mreģnom suļelju 
potrebno je napraviti ove korake da bi se dobio popis mreģnih suļelja:  
Start > Povezivanje s > Prikaģi sve veze. 

Kod uporabe izbornika Classic Start za postavljanje autentikacije na mreģnom suļelju 
potrebno je napraviti ove korake da bi se dobio popis mreģnih suļelja: 
Start > Postavke > Mreģne veze. 
 
Zatim treba desnom tipkom miġa kliknuti na naziv mreģnog suļelja (Local Area Connection) 
i odabrati Svojstva kao na Slici 1. 

Slika 1 

Nakon otvaranja prozora Svojstva Local Area Connection, podeġava se prihvaĺanje 
postavki dodijeljenih DHCP protokolom. Potrebno je odabrati Internet Protocol (TCP/IP) i 
kliknuti miġem na dugme Svojstva kao na Slici 2. 



 
Slika 2 

Otvara se novi prozor u kojemu moraju biti oznaļene moguĺnosti (Slika 3): 

 - Automatski pribavi IP adresu 

 - Automatski pribavi DNS adresu posluģitelja 



 
Slika 3 

Nakon klika miġem na dugme U redu i povratka na prozor Svojstva Local Area 
Connection, potrebno je odabrati karticu Provjera.  

U sluļaju da nemate karticu Provjera, ako se koristite zakrpom Windows XP Service Pack 2, 
provjerite je li pokrenut servis Wireless Zero Configuration. Ako se koristite zakrpom 
Windows XP Service Pack 3, provjerite je li pokrenut servis Wired AutoConfig. 
Za namjeġtanje bilo kojeg od ova dva servisa koriste se potpuno isti koraci, a ovdje je 
prikazan primjer namjeġtanja servisa WiredAutoConfig. 

 
Kod uporabe standardnog izbornika Start do prozora sa servisima dolazi se na ovaj naļin: 
Start > Upravljaļka ploļa > Idi na klasiļni prikaz > Administrativni alati > Servisi. 

 
Kod uporabe izbornika Classic Start do prozora sa servisima dolazi se na ovaj naļin: 
Start > Settings > Upravljaļka ploļa > Idi na klasiļni prikaz > Administrativni alati > 
Servisi. 

 
Desnim klikom miġa na servis otvara se izbornik iz kojeg je potrebno odabrati Svojstva 
(Slika 4). 



 
Slika 4 

U postavkama servisa iz padajuĺeg izbornika Startup type potrebno je odabrati moguĺnost 
Automatic, kliknuti miġem na dugme Start, a zatim na dugme OK (Slika 5). 

 
Slika 5 

Na kartici Provjera postavite kvaļicu pored Omoguĺi IEEE 802.1X provjeru za ovu mreģu i 
odaberite SecureW2 EAP-TTLS za Vrsta EAP-a. TakoĽer je potrebno provjeriti da nema 
kvaļice pored Provjeri kao raļunalo kada su dostupne informacije o raļunalu i Provjeri 
kao gosta kada nisu dostupne informacije o korisniku ili raļunalu. Sve postavke trebaju 
biti kao na Slici 6. 



 
Slika 6 

Klikom miġa na dugme Svojstva otvara se prozor SecureW2 Profile u kojem je potrebno 
odabrati profil StuDOM kao na Slici 7. 

 



 
Slika 7 

Na kraju je dovoljno klikom miġa na dugme OK zatvoriti otvorene prozore vezane uz mreģna 
suļelja. 

Nakon prikljuļenja mreģnog kabela, operacijski sustav Microsoft Windows XP zatraģit ĺe 
unos podataka potrebnih za autentikaciju (Slika 8). 

 

 
Slika 8 

Klikom miġa na obavijest otvara se prozor SecureW2 Credentials u koji upisujete svoju 
AAI@EduHr korisniļku oznaku i lozinku (Slika 9). 


























































































































































